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ES-PROHLÁŠENÍ O SHODĚ 

Výrobce: Kaindl-Schleiftechnik 
Reiling GmbH Remchinger 
Straße 4 

75203 Königsbach-Stein 
 
tímto prohlašuje, že následně popsaný stroj: 

UNIVERZÁLNÍ BROUSÍCÍ STROJ 
: Typ: FSM-CNC 

 
 
splňuje požadavky na bezpečnost a ochranu 
zdraví následujících směrnic ES: 

Směrnice ES o strojních zařízeních 
(2006/42/ES) 
Směrnice o zařízeních nízkého napětí ES 
(73/23/EG) 
Směrnice ES o EMC (89/336/ES) 

 
Použité harmonizované normy: 

EN ISO 1 21 00-1 a EN ISO 1 21 00-2; EN ISO 1 3857; EN 563; 
EN 61 029-1 , EN 60204 část 1 ; EN 61 000-6-1 ; EN 61 000-6-2; 
EN 61 000-6-3; EN 61 000-6-4 

 
Konstrukční změny, které mají vliv na technické údaje uvedené v návodu k obsluze a na používání k 
určenému účelu, a které tedy stroj podstatně mění, vedou ke ztrátě platnosti tohoto prohlášení o 
shodě! 

 
Tuto dokumentaci sestavil: Reinhard Reiling 

 
Kaindl-Schleiftechnik 
Reiling GmbH 
Remchinger Straße 4 
75203 Königsbach-Stein 
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1. NÁLEŽITÁ A SVĚDOMITÁ PÉČE 
PROVOZOVATELE 

Univerzální brousicí stroj FSM-CNC byl navržena a vyroben s přihlédnutím k 
analýze možných nebezpečí a také k příslušným harmonizovaným normám a 
dalším technickým specifikacím, které je nutné dodržovat. Díky tomu splňuje 
stav techniky a zaručuje nejvyšší míru bezpečnosti. 

 
Této bezpečnosti lze v provozní praxi dosáhnout pouze v případě, pokud byla 
přijata všechna k tomu nezbytná opatření. Součástí náležité a svědomité péče 
provozovatele stroje je tato opatření plánovat a kontrolovat jejich provádění. 

Provozovatel musí zejména zajistit, aby: 
 
• se stroj používal pouze podle v souladu určením 

(viz kapitola "Technický popis") 
• byl provozován pouze v bezvadném funkčním stavu, zejména 

bezpečnostní zařízení je nutno pravidelně kontrolovat na správnou funkci  
• návod k obsluze byl vždy čitelný a plně dostupný v místě používání 

stroje a byl uchováván pro budoucí použití 
 

• nebyly odstraňovány a zůstávaly stále upevněné a čitelné veškeré 
bezpečnostní a výstražné pokyny 
 

• byly dodržovány a prováděny všechny údržbářské a výstražné pokyny 
 

• byla prováděna kontrola a doplnění maziva. 
 
 
 
 

2. POŽADAVKY NA 
PRACOVNÍKY OBSLUHY 

Univerzální brousící stroj FSM-CNC smí obsluhovat pouze osoby, které byly 
seznámeny se zásadami zacházení CCNC stroje, kteří znají návod k provozu, 
návod k programování a zde uvedené bezpečnostní pokyny. 
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3. TRANSPORT 
 

Z výroby je univerzální brousící stroj FSM-CNC dodáván v dřevěné krabici. 
Hmotnost stroje, vč. balení činí, v závislosti na výbavě, 425 - 460 kg. 
Transport se provádí přímo do místa instalace vysokozdvižným vozíkem nebo 
vidlicovým zdvižným vozíkem. 

 
Před uvedením do provozu zkontrolujte stroj na poškození při transportu! 

 
Transportní škody je ihned po jejich zjištění ohlásit dopravci a zjištěné škody 
zaprotokolovat. 

Pozor: Platí a byly určeny velmi krátké reklamační lhůty!! 
 
 
 

4. ROZMĚRY A HMOTNOST 
Rozměry D x Š x V: 1 200 x 880 x 1 700 
mm hmotnost základního vybavení bez řízení: 352 kg 
Hmotnost řízení: 37 kg 

 

5. PODMÍNKY PROSTŘEDÍ 
Stroj smí být instalován pouze v suchých místech. Klimatické požadavky: 
od +5° do +50°C, vzdušná vlhkost 90%, bez kondenzátu. 

 
Elektrické připojení se děje přes vidlici s ochranným kontaktem CEE 7/7 (1 ~ 230V/50Hz; 
1 6A) 
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6. BEZPEČNOSTNÍ POKYNY 
Při zacházení s řeznými a frézovacími nástroji je nutno dbát na maximální opatrnost. Tyto 
nástroje mohou být ostré jako břitva na holení. Pokud nebude dodržována nutná opatrnost, 
může dojít k pořezání. 
Při upevňování a snímání ostrých obrobků noste rukavice odolné proti proříznutí. 

 
Spusťte program CNC pouze tehdy, pokud je jistota, že existuje správné nastavení a uložení 
nulových bodů. Program CNC je nutno před prvním spuštěním podrobit testovacímu běhu s 
dostatečnou bezpečnou vzdáleností od brusného kotouče. 

 
Programovací chyby nebo chyby v programovacích parametrech mohou u stroje způsobit 
věcné škody! 

 
Při běžícím softwaru CNC nezasunujte ani nevytahujte žádné zařízeni USB (např. USB flash 
disk)! Mohlo by pak dojít k poškození JOG-Wheelu (digitálního ručního kolečka řízení)! 

 
Ochranné kryty stroje chrání vedení, vřetena a spínače před nečistotami a mazivy. Při čištění 
stroje je zakázáno provádět oplachy vnitřních částí ochranných krytů chladicími mazivy nebo 
čisticími prostředky! 

Stroj je vybaven vřeteny brusného kotouče s regulovatelným počtem otáček. Prosím, dbejte 
při výměně brusných nástrojů na max. povolenou rychlost broušení brusného nástroje (m/s) a 
před zapnutím tuto rychlost přizpůsobte vřetenu brusného kotouče. 

 
Příliš vysoký počet otáček může způsobit praskání brusného nástroje, jehož 
následkem může být poškození stroje nebo vážná zranění !! 

 

7. SPRÁVNÉ POUŽÍVÁNÍ 
Univerzální brousící stroj FSM-CNC je určen výlučně k broušení frézovacích a různých řezných 
nástrojů. Tvorba programu pro broušení probíhá v souladu s DIN 66025 (kód G), resp. pomocí 
dodaných programů pro broušení. Broušení lze provádět přes elektrické vřeteno pro vnější 
broušení nebo pomocí vřetene HF pro vnitřní broušení. 

 
K správnému používání patří rovněž přečtení a pochopení tohoto návodu k obsluze a také 
dodržování všech pokynů v něm obsažených. 

 
Provozovatel sám nese odpovědnost za všechny věcné a osobní škody, které plynou z 
nesprávného používání nebo z programovacích chyb nebo chyb programovacích 
parametrů. 
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8. INSTALACE STROJE A PŘIPOJENÍ 
ŘÍZENÍ 

 

Stroj postavte na dodané stavěcí nohy a pomocí vodováhy proveďte nivelaci. 
Je důležité, aby stroj stál na všech čtyřech nohách pevně a bez vibrací. 
Instalujte sadu kol k řídící konstrukci a dbejte na to, aby byly brzdové válečky 
instalovány vpředu (na straně obsluhy). 
Dalším krokem je připojení řízení ke stroji. Za tímto účelem je nutno na pravé 
straně stroje otevřít černou kabelovou konzolu.  Uvolněte oba šrouby (M6) 
pomocí imbusového klíče 4 mm a kryt konzoly vyklopte nahoru. Nyní lze táhnout 
kabely s konektory a zafixovat černou hadici kabelu uzavřením konzoly. Montáží 
obou dolních šroubů konzolu opět přišroubujete a zajistíte tak pevnou montáž a 
ochranu proti tahovým silám. Po otevření čelních dvířek zhotovíte konektorové 
spojení (viz str. 8). 

 
 

Kabelová konzola 
 
 
 

za účelem otevření kabelové konzoly 
odstraňte pouze tyto dva šrouby. 

 
 

 

Sada kol na řídící konstrukci. Poté 
nasaďte kryty. 

 
Pozor: 

Stroj instalujte na pevném stanovišti 
bez ohrožení vibracemi! 

Montáž je nyní hotová. 
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Konektor Síť  Řízení Konektor 

nouzového 
vypnutí 

Konektor pro ruční kolečko 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

25 pólový konektor Sub-D s kolíky  25 pólový konektor Sub-D s pouzdrem 
 
 
 

POKYN:  
 
Konektory jsou mechanicky kódované a nelze je zaměnit! 
Konektory Sub-D jsou barevně a mechanicky kódované a nelze je zaměněné 
připojit!  
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9. ODSTRANĚNÍ TRANSPORTNÍHO ZAJIŠTĚNÍ  
 

Po bezpečné instalaci stroje FSM-CNC na nohách a připojení řízení je nutno 
odstranit transportní zajištění. 

 
1. Odstraňte oba černé vazače kabelů (obr 2), vybalte upínací 

páku, upínací páku nasaďte na upínací šroub (viz obr. 1) a 
otevřete upnutí. 

2. Pomocí vidlicového klíče SW 13 odstraňte černý 6-hranný šroub u 
transportního zajištění os (obr. 2).  

3. Odstraňte vrstvu tuku na sloupku Z a olejový papír v kuželu SK 40 osy A. 
Poté zapojte stroj a spusťte CNC-Software, aby bylo možné v ručním 
režimu vyjet osou Z nahoru. 

 
Odstraňte vrstvu 
tuku nebo vosku!! 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hlavní transportní zajištění 
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10. ODSTRANĚNÍ TRANSPORTNÍHO ZAJIŠTĚNÍ 
VNITŘNÍ KONZOLY 

M 

 
1. Vpravo a vlevo na konzole stroje odstraňte 2 pozinkované 

imbusové šrouby SW 8 na signálně červeném transportním 
zabezpečení. 

2. Odstraňte signálně červená transportní zajištění. 
3. Připojte zařízení pro chladicí prostředek a naplňte ho 

chladicím mazivem. 
 
Po odstranění všech transportních zajištění lze FSM-CNC uvést do provozu. 

 
Uchovejte všechny části transportního zajištění pro budoucí použití !!! 
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11. POPIS ZAŘÍZENÍ CHLADÍCÍHO ZAŘÍZENÍ 
 
 

Hadice odvodu chladícího prostředku 
FSM-CNC 

 
 
 
 

3 stupňový spínač 
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Nádobu chladícího prostředku je nutno naplnit ze 3/4 objemu chladícím 
mazivem. V napojení proveďte odvzdušnění čerpadla chladícího prostředku. 

 
Zařízení chladícího prostředku připojte k modré zásuvce stroje. Pro 
odvzdušnění čerpadla otevřete odvětrávací šroub čerpadla. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Důležité informace k chladícím mazivům: 

 
Prosím, používejte výlučně emulze mísitelné s vodou na bázi minerálních olejů. 
U syntetických výrobků může dojít k značným škodám laků, různých dílů plastů 
a ložiskových těsnění. Za tyto škody nepřebíráme žádnou odpovědnost. Při 
testování chladících maziv dodržujte odpovídající směrnice příslušných výrobců 
maziv. 

 
Prosím, dodržujte stávající předpisy platné pro likvidaci. 

Zásuvka pro zařízení 
chladícího prostředku 
1 ~230V/50Hz Max. 3A 
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12. VYSVĚTLENÍ NUMERICKÝCH OS 
 
Tyto FSM-CNC jsou vybaveny 4 numerickými osami. 3 z toho jsou definovány jako lineární 
osy (X; Y; Z), jedna osa (A) je kruhová. Na spodním obrázku je zobrazeno přiřazení os. 
Model se směry je umístěn v zorném poli vřetena brusného kotouče (jakoby se vřeteno 
brusného kotouče pohybovalo prostorem). 

 

 
 

Model se směry v zorném poli vřetena brusného kotouče 

POKYN: 
Osy X; Y; a Z jsou definovány v jednotce "mm". Osa A je definována ve "stupních", tzn. jedno 
otočení činí 360°, místa, která se nachází za desetinnou čárkou, jsou desetinná. Údaje o 
posuvu jsou proto udávány v "mm/min" a " °/mm". 

Držák pro měřicí senzor 
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13. KONSTRUKCE FSM-CNC 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Upnutí SK 40 

Připevnění kamerového systému Kulový kohout pro chladící prostředek 

Upevnění osy Z 

Hadice chladícího prostředku 

Aretace osy A 

Vřeteno brusného kotouče 
(vřeteno E) 

Upevnění úhlového nastavení osy A 
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14. SEŘÍZENÍ VŘETENE HF (VARIANTA) 
 
 

 

Pomocí regulačního imbusového šroubu SW 5 je nutno srovnat vřeteno HF 
osově souběžně k ose X a zajistit kontramaticí SW 10. Teprve poté utáhněte 
vřeteno pomocí upínacího šroubu na držáku vřetene. Vřeteno HF lze 
nastavovat v podélném směru povolením upínacího šroubu na držáku 
vřetene. 

 

Vřeteno HF lze zajišťovat i 
vertikálně. 

 
 
 

 

 
Regulace otáček 6000 - 24000 U/min 

Regulační šrouby pro vyrovnání 
vřetene brusného kotouče 

Upínací šroub SW 5 Držák 
vřetene 
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15. PŘIPOJENÍ VŘETENE HF A OSY A 
 
 
 
 

 
 
 
 

Pokyn: 
Pro všechna připojení stroje platí: 

Zasouvání a vytahování připojení provádějte pouze při vypnutém stroji 
!! (Vypnutí sítě na hlavním spínači) 

 
 
 
 
 
 
 

 

Připojení motoru 
osy A 

Připojení spínače 
referenčního bodu 

Připojení vřetene 
HF 
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16. MANUÁLNÍ MOŽNOSTI NASTAVENÍ 

U FSM-CNC existuje několik dodatečných, manuálních možností nastavení, 
která z tohoto stroje činí velmi univerzální brousící stroj. Osu Z lze nastavit ve 
dvou dalších rovinách a tak zde vznikají četné možnosti pro opracování určitých 
nástrojů brusným kotoučem. 

 

 
 

16.1 HORIZONTÁLNÍ NASTAVENÍ 
Po uvolnění obou upevňovacích šroubů, a po otočení regulačního šneku pomocí 
ráčny, dochází k otočení celé věže osy Z. 

 
Upevňovací šrouby 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Úhlová 
stupnice v ° 

Ráčna s oříškem SW 
12 na regulačním 
šneku 
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16.2 VERTIKÁLNÍ NASTAVENÍ ÚHLU 

Pomocí ráčny povolte zadní šestihranný šroub upínacího oválu. Nastavte nyní 
vertikální úhel na regulačním šneku vertikálního nastavení. Pokud se vám to 
zpočátku nebude dařit, lehce shora poklepejte držadlem ráčny na šroub 
upínacího oválu, by se mohl snáze uvolnit. 

 
 
 
 

Ráčna s oříškem SW 12 
 
 
 
 
 

Šestihranný šroub upínacího 
oválu 

 
 

Regulační šnek 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Úhlová stupnice v ° 
 
 
 
 

Po nastavení požadovaného úhlu upínací ovál, příp. upevňovací šroub, opět 
dotáhněte. 
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17. KONSTRUKCE ŘÍZENÍ CNC 

Řízení IPC je vybaveno dotykovou obrazovkou. Tlačítka obslužné plochy lze 
aktivovat dotykem. Řízení IPC disponuje klávesnicí s touchpadem. Jako 
dodatečné zajištění vašich programů CNC slouží rozhraní USB 3.0 pomocí USB 
flash disku. 

 
 
 
 

Dotyková 
obrazovka 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Hřib nouzového 
vypnutí 

 
 
 
 
 
 
 
 

Touchpad 
 

POZOR!!! 
 
Při běžícím CNC softwaru nikdy nezasunujte ani nevytahujte žádné zařízeni USB 
(např. USB-flash disc)! Mohlo by dojít ke zničení JOGWheelu! 
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18. TECHNICKÉ ÚDAJE  
Rozsah pojezdu v X: 300 mm 
Rozsah pojezdu v Y: 135 mm 
Rozsah pojezdu v Z: 192 mm 
Brousící motor : 3~230V/1 00Hz, 0.75 KW, 1 330 - 6640 r/pm 
Vřeteno HF (varianta): 3~230V/400Hz 0,8KW, 6000-24000 r/pm 
hodnota připojení stroje se řízením: 1 ~230V/50-60 Hz, 1 .8 KW max. 
počet numerických os 4 (X; Y; Z; A) 
Odsávací přípojka: příprava s vrtem pouzdra ø 100 mm 
Rozměry D x Š x V: 1200 x 880 x 1700 mm 
hmotnost stroje bez řízení: 352 kg 
Zjištěná hladina akustického tlaku < 70 dB/A 
Elektrické připojení: Kabel s vidlicí s ochranným 

kontaktem CEE 7/7 (1 
~230V/50Hz) 

Řízení: Řízení IPC s 15" dotykovou obrazovkou 
Intel i5 procesor; 4 GB RAM; 
1 60GB Sata Harddisk , 2x GBit LAN ; USB3.0 

 
Provozní systém: Ubuntu 1 2.04.5 LTS i386 "Precise Pangolin" 

Rtai Kernel; vhodný do el. sítě; vhodný pro 
vzdálenou údržbu 

 
CNC-Software: LinuxCNC  verze 2.7.4 
Grafický povrch: Kaindl, specifický pro TKLinuxCNC Basis 

"Deus in Machina" 
Hmotnost řízení netto: 37 kg 

Čerpadlo chladícího prostředku: 

Motor: 1 ~230V / 50 Hz 
Výkon, stupeň 1: 0.028 KW 
Výkon, stupeň 2: 0.045 KW 
Výkon, stupeň 3: 0.063 KW 
Krytí: IP65 
Přepravní výkon: 16 až 35 l/min 

 
 
Technické změny vyhrazeny! 
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19. ZAPNUTÍ STROJE 

Zapněte stroj vpravo dole na konzole stisknutím zeleného tlačítka. Zapne se 
osvětlení stroje a řízení rozběhne provozní systém. 

 
 
 
 
 

Vypnutí stroje 
 
Zapnutí stroje 

 
 
 
 
 
 
 
 
 

POKYN: Před vypnutím stroje vždy zcela ukončete řízení! 
 
Po spuštění řízení sledujte spínací obrazovku. K dispozici jsou dvě konfigurace stroje: 
1. Kaindl-FSM-Kruh je 3-osová konfigurace pro rotační broušení nebo vnitřní broušení 

válcových ploch. (Osa A je konfigurovaná jako vřeteno) 
2. Kaindl-FSM-CNC je 4-osová konfigurace pro broušení řezných a frézovacích nástrojů 

 
POKYN: Každá konfigurace má vlastní nezávislou programovou složku.   Po kliknutí 
na příslušný obrázek se spustí CNC-Software LinuxCNC. 
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20. GRAFICKÁ PŘÍKAZOVÁ PLOCHA TK 
Příkazová plocha TK je vhodně přizpůsobena stroji. Níže uvádíme nabídky a 
funkce: V nabídce Help -> Help naleznete stručný návod k funkcím klávesnice, k 
jednotlivým nabídkám a kódům G a M. 
Po spuštění softwaru je nutno stroj zapnout tlačítkem F2. Značení os a 
znázornění skutečných hodnot je nejprve znázorněno v žluté barvě, což 
odkazuje na chybějící referenci os. 

 

 
 

REFEROVÁNÍ STROJE 
Referování stroje se provádí stisknutím tlačítka "Home Machine". 
Výsledkem této aktivace je zpráva "homing sequenz already in progress", kterou 
je nutno potvrdit OK. Po provedení referenčního běhu se znázorní značení os a 
skutečné hodnoty v zelené barvě. 

 
Bez platných referenčních bodů není práce v automatickém režimu nebo v MDI 
možná. 

 
Stisknutím tlačítka "Home Axis" se provádí referování pouze pro zvolenou osu. 
 

 
 
 

Zvolená osa 
 
 
 
 
 

Řádek pro 
zadávání MDI 

Přerušení 
programu nebo 
jakéhokoli pohybu 

 
 
 
 
Volba přírůstku pro 
ruční kolečko 
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21. POPIS NABÍDKY 
 
V nabídkách TK naleznete mnoho užitečných funkcí a pomocných prostředků, které usnadní 
práci, příp. chybovou diagnózu. Funkce, které jsou důležité pro vaši práci, jsou dále popsány: 

 

 

Nabídka souborů 
File > Open Otevře program CNC 
File > Edit Otevře interní editor pro zpracování programu 

CNC 
File > Tool Table Editor Otevře tabulku nástrojů pro náhled, příp. pro zpracování. 

File > Reload Tool Table Načtení tabulky nástrojů do paměti NC File 
> Reset Vrátí otevřený program CNC opět zpět (resetování 

programu) 
File > Exit Ukončí LinuxCNC 

 
Nabídka View 
View > Offsets and Variables Otevře k náhledu EMC.VAR nebo ke zpracování View > 
Diagnostic Otevírá diagnostické okno (pouze pro výrobce) 
View > Backplot Otevírá náhled Backplot, který znázorňuje průběhy pohybů 

v prostoru. Znázornění jsou však pouze lineární, nejsou 
znázorněny kruhové osy.  

Nabídka Settings 
Settings > Calibration Není určeno pro 
uživatele 
Settings > Debug Není určeno pro 
uživatele 
Settings > Font Slouží pro individuální nastavení druhu písma 

 
Nabídka Units 
Units > auto Měrná jednotka konfigurace stroje je platná 
Units > inch Všechny rozměry jsou v coulech (inch) 
Units > cm Všechny metrické rozměry jsou v cm 
Units > cm Všechny metrické rozměry jsou v mm (Default) 

 
Nabídka Utillities 
Utillities > HAL-Scope Slouží ke kontrole funkce Real Time 
Utillities > HAL-Meter Slouží ke kontrole různých signálů 

 
Nabídka Scripts 
Scripts > Set Coordinates Otevírá dialogové okno k umístění NPV (G54 - 

G59.3) 
Zobrazení Scripts > HAL Není určeno pro uživatele 
Konfigurace Scripts > HAL Není určeno pro uživatele 
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22. FUNKCE CHODU PROGRAMU CNC 
 
Funkcionalita průběhu programu je téměř samozřejmé. 

Open ... Otevře dialog pro volbu disponibilního CNC programu  

Run Spustí zvolený CNC program 

Pause Zastaví běžící CNC program 

Resume Spustí zvolený CNC program 
 
Step CNC program je zpracováván řádek po řádku a za každým řádkem se 

zastaví do okamžiku aktivace povelu "Pokračovat", kdy se spustí další 
řádek. 

Verify Kontrola syntaxe otevřeného programu CNC 
 
Optional Stop Tímto tlačítkem stanovíte, zda bude zastavení programu 

provedeno pomocí M1 nebo ne 
 
 
 
 

 
 
 

POKYN: 
 
U otevřených dveří stroje nebo při nízkém stavu mazání (centrální 
mazání se nachází pod MIN) není možný přechod do některých z 
automatických režimů (Auto nebo MDI)! 

 

 
Zde se zobrazí otevřený program CNC! 
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23. UPNUTÍ FRÉZOVACÍCH NÁSTROJŮ 
Upnutí frézovacích nástrojů FSM-CNC provádíme pomocí standardních nástrojových upínání 
pomocí kuželu SK40. Osa A tento kužel může přesně upnout. V podstatě lze použít každý 
upínač nástrojů SK40 bez vtahovacího čepu (viz obr.), rozdíly existují samozřejmě rovněž v 
přesnosti chodu. 
Doporučujeme proto používání upínačů nástrojů v dobré kvalitě. 

Obrázek 3: Standardní upínač SK40 se systémem upínacích kleští ER32 
 
 

SK40 bez vtahovacího čepu 
 
 
 
 
 
 
 
 
 

ER32 systém upínacích 
kleští 

Vnitřní závit M16 

 
 
 
 
 
 

Nos unašeče 
 
 
 
 
 
 
 
 
Upínač SK40 se zavádí pomocí upnuté frézy zepředu do vnitřního kuželu osy 
A. Prosím nezapomeňte, že vnitřní kužel i upínač SK40 musí být čistý a bez jakýchkoli 
nečistot. Ze zadní strany osy A utáhněte imbusovým klíčem SW8 upínač SK40. Je nutné dbát 
na správnou drážku nosu. 

POKYN: 
Po každém upnutí na osy A proveďte jízdu referenčního bodu osy A! 
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Utažení upínače nástroje SK40 se děje zezadu pomocí imbusového klíče SW8, 
pro protidržení stiskněte aretaci. 

 
POKYN: V 3 osové konfiguraci (FSM-kruh) je osa A dodatečným vřetenem a 
nedisponuje orientovaným zastavením v bodu aretace! 

Obrázek 3: Osa A bočně s aretací a upevňovacím šroubem vzadu. 
 

 

24. ÚHLOVÉ NASTAVENÍ NA OSE A 
Osa A disponuje dodatečným nastavením úhlu, které umožňuje broušení 
kuželových obrobků bez interpolace, příp. slouží i k naostření frézy na vnitřní 
straně. 

 

 

Úhlová stupnice v ° 

Upnutí úhlového 
nastavení 

26  



 

 

25. SEŘÍZENÍ MĚŘICÍHO SENZORU  
 
Instalujte dodaný mechanický měřící senzor na držák měřícího senzoru na skříni 
brusného vřetene (viz obr.) 
Měřící senzor lze instalovat téměř v každém směru. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Šroub (SW 2,5) k upevnění 
měřícího snímače 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Šroub (SW 2,5) k upevnění 
držáku měřícího snímače. 
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25.1 SEŘÍZENÍ KAMERY 

Instalujte kameru na dodaný držák, viz obr. 1, dále nainstalujte dodaný softwarový balíček 
do svého notebooku (tento není součástí dodávky). 
Správný postup instalace naleznete v příručce v kamerovém balíčku nebo na 
CD, které je součástí dodávky.  
Po instalaci spojte kameru s USB vstupem stroje (obr. 3) a USB kabel stroje spojte s 
notebookem.  
Po spuštění softwaru lze v notebooku sledovat živý obraz kamery. 
Ve vzdálenosti cca 100mm před kamerou přiložte příložný úhelník, viz obr. 1, a zaostřete 
obraz. 

Na softwarové ploše kamery klikněte na  tlačítko a zvolte zaměřovací kříž. 
Pomocí zobrazeného zaměřovacího kříže a příložného úhelníku vyrovnejte otáčením kamery v 
držáku na vertikální rysku (obr. 2) a zafixujte kameru dotažením upínacích šroubů (SW4).   
Pouze dotáhnout, prosím, nepoužívejte násilí ! 

 
 

Obr. 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obr. 3 

 
Obr. 2 

 
 
 
 
 

Upínací šroub 
(SW4) 
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26. DOTYK OBROBKU A STANOVENÍ NULOVÉHO 
BODU OBROBKU 

V ručním režimu je obrobek dotykově snímán digitálním ručním kolečkem ve 
všech  4 (3) osách. Volba os pro nastavení ručním kolečkem probíhá dotykem 
příslušného osového ukazatele na dotykové obrazovce. Nulování se provádí 
funkcí "Set_Coordinates" z nabídky "Scripts", stiskem tlačítka "Teach". Poté 
stiskněte tlačítko "Write" a poté "Close". Obrobek je nyní vynulován. 

Jsou instalovány následující NPV k pevnému využívání v programech Kaindl: 
• Obrobek G54, NPV pro vřeteno E 
• Obrobek G55, NPV pro vřeteno HF (varianta) 
• Brusný nástroj G56, NPV pro přípravný přípravek (vřeteno E a vřeteno HF) 
• Měřící senzor G57, NPV pro měřící programy 

G58 až G59.3 jsou volně k dispozici pro uživatele. 
 
POKYN: Digitální kolečko lze osadit různými rozšířeními a v případě 
„Durchgehend (průběžné)“ je mimo funkci. Disponibilní rozšíření: 0.005; 0.01 ; 
1.25 mm na každou aretaci na ručním kolečku nebo poklepáním na tlačítka "+" 
oder " - ". 

 

 
Volba NPV Pro volbu rozšíření stiskněte zde 
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27. MĚŘENÍ FRÉZY 
Frézy se měří ručně dodaným mechanickým měřícím senzorem. Důležitý je 
zde úhel bočních břitů, tyto jsou součástí dodaného programu broušení pro 
frézy#6 (Stoupání bočního břitu ° na mm délky frézy) 

 
- Upněte frézu do upnutí osy A a pomocí kamery vyrovnejte první 
hlavní boční břit podle zaměřovacího kříže. 

- Měřicí senzor sklopte a v ručním režimu se jím dotkněte předního bodu 
bočních břitů, měřicí senzor nastavte na "Nulu". Na nulu rovněž nastavte 
ukazatel osy A pomocí "Set Coordinates". 

- Osou X najeďte 10 mm do směru upnutí a pomocí ručního kolečka 
pohybujte osou A dokud se měřící senzor nebude nacházet na Nule. 

- Na ukazateli osy A (obrazovka) vyčtěte hodnotu úhlu a vydělte 
pojezdovými 10mm. 

 
Příklad: 

 
V X došlo k pohybu osy o 10mm ve směru upnutí, osový ukazatel osy A 
zobrazuje hodnotu ve výši 39.5°.  
Hodnotu 39.5° vydělte 10 mm a získáte hodnotu3.95° 
Tuto hodnotu zapište do brousícího programu frézy un #6=3.95 . (viz str. 32) 

 
 

1. Měřící poloha 2. Měřící poloha 
 

  
 

Pokyn: 
Jako variantu lze objednat kabelově připojený hranový senzor 3D KT1 
30. Hranovým senzorem lze zajišťovat automatizované měření !! 
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28. DOTYK FRÉZY 
V následujícím příkladu bude vysvětleno, jak, a na jakých plochách je dotyk 
frézy prováděn, aby bylo možné pomocí našeho standardního programu 
provádět ostření frézy. Prosím, nezapomínejte, že námi dodané programy 
mohou ostřit čistě standardní frézy, nepatří sem zvláštnosti jako např.: 
• rozdílně dělené řezné hrany 
• asynchronní spirálové úhly 
• řezající nad středem 

 
Pokud tyto zvláštnosti budete potřebovat, můžete si tyto programy sami zhotovit 
v kódu G. Samozřejmě je rovněž možné, stávající programy přizpůsobit a tyto 
vybavit veškerými funkcemi, které budete potřebovat pro své speciální řezací a 
frézovací nástroje. 

 
Osa Z se nyní musí pohybovat do polohy středu osy A (přesný rozměr naleznete v 
protokolu měření stroje pod bodem 4). 
Z nabídky "Scripts" zvolte"Set Coordinates", aby bylo možné vynulovat osu Z 
vG54 . Tuto poté převezmete pomocí "Write" a "Close". 
V ručním režimu (tlačítko F3) zapněte vřeteno brusného kotouče tlačítkem 
F10 a ručním kolečkem se pomalu dotkněte vyrovnané řezné hrany frézy v 
ose X. (viz obr. níže) 

 
Z nabídky "Scripts" zvolte"Set Coordinates", aby bylo možné vynulovat osu X v 
G54 . Tuto poté převezmete pomocí „Write“a"Close". Pomocí ručního kolečka 
se nyní pomalu dotkněte v Y bočního břitu frézy. (viz obr.) 
Z nabídky "Scripts" zvolte"Set Coordinates", aby bylo možné vynulovat osu Y 
vG54 . Tuto poté převezmete pomocí "Write" a "Close". 

 
Frézou pohybujte několik mm pomocí ručního kolečka v Y směrem od brusného 
kotouče a pohybujte osou A do hodnoty úhlu 2. Fáze řezu. Poté se opět 
dotkněte se frézy v Y a poznamenejte si hodnotu ukazatele Y. Tuto hodnotu je 
nutno zaznamenat v Parameteru #34 "hodnota dotyku 2 fáze". 

 
Ručním kolečkem nyní pohybujte frézou v Y a poté v X cca 3-4 mm směrem od 
brusného kotouče. Fréza je nyní vynulována pro broušení. 

 
 
 
 
 
 

Dotyk osou 
X 

Dotyk osou 
Y 
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29. BROUŠENÍ STANDARDNÍ FRÉZY 
 

Jestliže nemáte žádné speciální frézy, můžete využít dodaného dialogu 
programů CNC, které jsou velmi jednoduché na ovládání. Stačí pouze vyplnit 
červenou oblast přímo za =. 
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Již popsaný program CNC "Fraeser_Dia_Komplett.ngc“ existuje i dílčích verzích jako čelní 
strana  "Stirnseite.ngc“ a "Fraeserspirale_Dia.ngc". Tyto umožňují ostření frézy v dílčích 
oblastech, tedy např. pouze spirálové břity nebo pouze čelní břity. Proměnné jsou přesně 
tytéž jako u "Fraeser_Dia_Komplett.ngc". 

 
Rozměry můžete doložit jinými rozměry a uložit pod jiným názvem, pod kterým je název 
potřeba uložit (do 256 znaků). Příponou pro programy CNC musí být .ngc. 

 
POKYN: Linux důsledně rozlišuje mezi velkým a malým písmem! 

 
Více informací k programování (DIN 66025 kód G) naleznete v návodu na programování. 

 
 
 

30. STROJEM DANÉ ZVLÁŠTNÍ FUNKCE 
(FUNKCE-M V KÓDU-G) 

M1 01 Přepnutí z vřetene brusného kotouče na vřeteno HF (varianta) 
M1 02 Přepnutí z vřetene HF na vřeteno brusného kotouče (varianta) 

 
M1 03 Zapnutí funkce pro systémy senzorového měření 
M1 04 Vypnutí funkce pro systémy senzorového měření 

 
M1 05 Zapnutí pilových kotoučů magnetické upnutí (varianta broušení pilových 
kotoučů) 
M1 06 Vypnutí pilových kotoučů magnetické upnutí (varianta broušení pilových 
kotoučů) 

 

30.1 REGULOVATELNÁ BRUSNÁ VŘETENA 
FSM-CNC je standardně vybavena regulovatelným brusným vřetenem a umožňuje proto 
přizpůsobení rychlosti broušení brusnému kotouči a materiálu obrobku. Nastavení se děje přes 
Poti, v měniči kmitočtu, který se nachází v skříňovém rozváděči. Rozsah nastavení se nachází 
mezi 10 až 50 m/s. 
Ukazatel je v m/s, počítáno na brusný nástroj Ø 125 mm. 

 
POZOR!!! 
Po výměně brusného nástroje je nutno, před zapnutím brusného kotouče, zkontrolovat 
max. rychlost brusného nástroje a tuto nastavit na měniči kmitočtu. Dbejte velké 
opatrnosti u korundových brusných nástrojů !! 

 
Příliš vysoký počet otáček může způsobit zničení brusného 
nástroje, jehož následkem může být poškození stroje nebo vážná 
zranění !!! 
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31. VÝMĚNA BRUSNÉHO KOTOUČE 
Před provedením výměny brusného kotouče vyjeďte osou Z zcela nahoru. 
Pomocí dodaného kolíčku Ø 6 mm zaaretujte brusný kotouč a povolte 
upevňovací šroub SW 4 ve středu příruby brusných kotoučů (viz obr.). 

 
 
 
 

Upevňovací šroub brusných kotoučů SW 4 
 
Aretovací kolíček Ø 6 mm 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Odtlačovací šroub 
M8 s SW 6 

 
 
 

Používejte pouze přiložený 
odtlačovací šroub M8 s SW 6 a tyto 
odtlačte s tímto brusným kotoučem 
včetně příruby brusných kotoučů od 
brusného vřetene. 

 
Nasaďte váš nový brusný kotouč na 
brusné vřeteno a dbejte na to, aby byl 
čep unašeče upínače brusných kotoučů 
nasazen do drážky brusného vřetene. 
Nyní pomocí imbusového šroubu 
opět upevněte brusný kotouč ve 
středu a utáhněte. 
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32. OROVNÁNÍ KORUNDOVÉHO BROUSICÍHO 
KOTOUČE 

Na FSM-CNC můžete používat i korundový brousící kotouč. Tyto brusné kotouče je nutno před 
použitím orovnat, aby bylo dosaženo rovnoměrného chodu brusného kotouče a mohlo být 
zaručeno co nejlepších výsledků broušení. Orovnání brusného nástroje se děje orovnávacím 
zařízením, na které je namontován orovnávací diamant PKD. Pomocí odpovídajících 
orovnávacích programů je možné do brusného nástroje navléci i formy, jako např. poloměry, 
hranolové tvary atp. 
V rozsahu dodávky existuje podprogram (1 000.ngc) pro obvodové orovnání. To může sloužit i 
jako příklad pro vlastní orovnávací programy. Tento podprogram bude po orovnání, v závislosti 
na přísunu, provádět NPV obrobku a NPV brusného kotouče v Z. Orovnávací diamant by se 
měl nacházet (viz obr.) cca 1 mm za středem v X a v NPV G56 by měla být nulována poloha. 

 
Bočně se dotkněte brusných kotoučů v Y a vynulujte v NPV G56 . Nakonec totéž proveďte ve 
směru Z a rovněž pro Z v G56 . Viz obr. 

 Nastavení: Dotkněte se orovnávacího diamantu cca 1mm  za středem brusného kotouče v Y. 

  
 

Dotkněte se brusného kotouče v Z 
v přísunovém pohybu v Z 
v orovnávacím pohybu v Y 
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Stejně jako korundové brusné nástroje vřetene E lze orovnat i korundová brusná tělesa 
zařízení pro vnitřní broušení (varianta vřetene HF). K tomu je nutno instalovat orovnávací 
zařízení, viz obr. níže, a je nutno provést dotyk NPV G56 pomocí "Set_Coordinates" z 
nabídky "Extras“ a uvedené uložit. 
Prosím, dbejte i v "Set_Coordinates" na nejvyšší funkci "GB" 
(grind body = brusný nástroj). Do parametrů #3000 pro vřeteno E brusného nástroje a do 
#3001 pro vřeteno HF brusného nástroje lze zapsat maximální míru orovnání, která bude 
rovněž v dodaných programech monitorována. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Orovnání: Korundový brusný kolík v zařízení pro vnitřní broušení 
 
 
 
 
 
 

Korundový brusný 
kolík 

 
 
 
 

Orovnávací diamant PKD 
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33. Elektrika FSM 
 
 

Regulátor pohonu pro X; Y; Z; A 
 
 
 
 
 
 
 
 
 

Ukazatel v m/s Regulátor otáček 
10 - 50 m/s 

 
Spínač FI Sekundární zajištění 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Relé 
 

Měnič kmitočtu 
brusného kotouče 

Měnič kmitočtu 
vřetene HF (varianta) Optoelektronický vazební prvek 

 
Pokyn: 
Ochranné spínače motoru měničů kmitočtu jsou integrovány do okruhu „nouzového 
vypnutí“. Spuštění spínače je indikováno hlášením "Nouzové vypnutí“ v LinuxCNC". 
POZOR: 

 
Tyto FSM-CNC jsou vybaveny jedním spínačem FI. Pokud nelze tento spínač aktivovat nebo pokud již 
aktivovaný spínač nelze opět zapnout, došlo k vážené chybě v elektrickém vedení.  Až do příchodu odborného 
elektrikáře a odstranění závady je zakázáno na stroji pracovat. Existuje zde ohrožení života elektrickým 
proudem! 

Prosím, vytáhněte elektrickou zástrčkou! 
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34. Tipy a triky 
Jelikož úhly způsobené čelními břity podléhají poloměru brusného kotouče, 
podložíme si to nyní stručně matematicky. 

 
 

Velikosti kruhového segmentu: 
 

 
 
 
 
 
 
 
Výpočet úhlu hřbetu: 
Vzoreček pro výpočet výšky Z S/2 = r x (SIN α) 
PŘÍKLAD: 
Brusné kotouče Ø = 1 25 mm; úhel hřbetu čelního břitu = 10° 

125 mm/2 = r = 62,5mm; α = 10° 
S/2 = 62,5x (SIN 10°) = 10,8530 mm 

 
Tzn., že na čelním břitu frézy musí osa Z s brusným kotoučem 1 vyjet 
10,8530 mm ze středu nahoru. 
Dalším krokem je převedení našeho nulového budu na novou polohu brusného 
kotouče. Tato hodnota se vypočítá jako h. 

Výpočet provedení nulového bodu: 
 
Vzorec pro výpočet provedení X h = S/2x TAN (α/2) S/2 
= 10,8530 mm x TAN 5° = 0,9495 mm 

Rozdíl k nulovému bodu X je 0,9495 mm. 
 
 
 
POKYN: Upozorňujeme, že se tyto vzorce mohou trošku lišit od výpočtů různých 
vzorcových sestav. Důvodem je to, že my se budeme matematicky vždy 
nacházet pod středem brusného kotouče. 
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35. SEZNAM NÁHRADNÍCH DÍLŮ 
Č. zboží Označení 

 
2771 7 Vodící sady osy Y- FSM-CNC: 

2 x Profilové lišty osy Y 
3 x Vozík kuličkového vedení 

 
1 771 8 Sada kuličkových šroubů osy Y - FSM-CNC: 

Kuličkové šrouby osy Y 12 x 4 / 218 mm kompletně s 
kuličkovou maticí 
2x ložisko pohybového šroubu, 
pojistka šroubu střední pevnost 5g, 
plstěná vložka pro olejové mazání 

 
1 771 9 Vodící sady osy X - FSM-CNC: 

2 x Profilové lišty osy X 
4 x Vozík kuličkového vedení 

 
1 7720 Sada kuličkových šroubů osy X - FSM-CNC: 

Kuličkové šrouby osy X 12 x 4 / 465mm kompletně s 
kuličkovou maticí 
Plstěná vložka pro olejové 
mazání, pojistka šroubu 
střední pevnost 5g, 2x ložisko 
pohybového šroubu 
2 x opěrné ložisko pohybového šroubu 

 
1 7740 Sada trapézových pohybových šroubů osy 

Z: Trapézové pohybové šrouby osy Z s 
bronzovou maticí, ložisko pohybového 
šroubu pro osu Z 

1 7721 Brusné vřeteno FSM-CNC (kompletní) 

1 71 04 Klínový řemen Optibelt VB Z397 Ld/1 0x375 Li Z1 4 

1 7723 Vodicí pero osy Z 1 2 x 8 x 81mm 

1 7724 Sada motorových ložisek, osový motor 2Nm (osy 
X; Y; Z; A) 
1 7234 Olejová hadice PU PK3 černá 1 m 

39  



 

 

36. SCHÉMA ZAPOJENÍ 
Schéma zapojení vašeho stroje naleznete ve skříňovém rozváděči vpravo Na 
Vnitřní straně. 

 
Pokud zde schéma zapojení nenaleznete, prosím obraťte se emailem na 
info@kaindl.de, toto schéma vám zašleme ve formátu PDF. 

 
Pokyn: 

 
Abychom vám zaslali správnou verzi, prosíme, vždy uvádějte číslo stroje a rok 
výroby 
. 

 
 
 
 

36.1 PŘIPOJENÍ 
Všechny zásuvné spoje u tohoto stroje jsou zhotoveny v typu krytí IP65. 
Aby byla zajištěna těsnost zásuvných spojů, je nutno tyto ručně pevně 
přišroubovat. 
Z důvodu průniku chladicího maziva je nutno nevyužité zásuvné spoje 
přišroubovat s dodanými kryty. 

 
 
 
 
 

USB-připojení pro kameru 
 
 
 

Připojení pro 3D-senzor - KT1 30 
 
 
 
 
 
 
 
 
 
 

Připojení magnetického upevnění 
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37. PŘÍSLUŠENSTVÍ 
Č. zboží Označení 

 
1 0895 Brusný kotouč ze vzácného korundu, zrno 60 (hrubé) 125 x 20 x 20 mm 
1 0890 Brusný kotouč ze vzácného korundu, zrno 80 (střední) 125 x 20 x 20 mm 
1 0891 Brusný kotouč ze vzácného korundu, zrno 1 80 125 x 20 x 20 mm 
1 0893 Brusný kotouč ze vzácného korundu, zrno 1 00 125 x 5 x 20 mm 
111 03 Brusný kotouč ze vzácného korundu, zrno 1 00 125 x 0 x 20 mm 
1 7303 Hrncový brusný kotouč CBN B76 ø 125 mm (Standard) 
1 7304 Hrncový brusný kotouč CBN B1 26 ø 125 mm 
1 7305 Hrncový brusný kotouč diamantový D76 ø 125 mm (Standard) 
1 7306 Hrncový brusný kotouč diamantový D126 ø 125 mm 
1 8292 Hrncový brusný kotouč CBN B76 ø 100 mm (např. záhlubník s vodicím čepem) 
1 8293 Hrncový brusný kotouč CBN B126 ø 100 mm (např. záhlubník s vodicím čepem) 
1 8294 Hrncový brusný kotouč diamantový D76 ø 100 mm (např. záhlubník s vodicím 
čepem) 
1 8295 Hrncový brusný kotouč diamantový D126 ø 100 mm (např. záhlubník s vodicím 
čepem) 
1 8296 Obvodový brusný kotouč CBN B76 ø 125 (pro rovinné a plošné broušení) 
1 8297 Obvodový brusný kotouč CBN B126 ø 125 (pro rovinné a plošné 
broušení) 
1 8298 Obvodový brusný kotouč diamantový D76 ø 125 (pro rovinné a plošné 
broušení) 
1 8299 Obvodový brusný kotouč diamantový D126 ø 125 (pro rovinné a plošné 
broušení) 
1 5422 Upínač brusných kotoučů FSM pro korundové, diamantové brusné kotouče a 

kotouče CBN 
1 5856 Orovnávací kotouč diamantový D356 

100 x 20 x 20 mm pro orovnání brusných kotoučů CBN s 
pojivem na bázi syntetické pryskyřice  

1 5857 Orovnávací kotouč na bázi karbidu křemičitého, zrno 80 
100 x 30 x 20 mm pro orovnání diamantových brusných kotoučů s pojivem na 
bázi syntetické pryskyřice 

1 5855 Brusný kámen 100 x 40 x 1 5 mm pro broušení brusných kotoučů s pojivem 
na bázi syntetické pryskyřice po orovnání 

1 6050 Přesná upínací hlava ER32 s indexováním např. jádrový vrták 
1 6051 Přesný sinusový magnetický stůl 
1 7675 Sada upínacích pouzder 18 dílný ER32; 3,0 - 20.0 mm; v prémiové kvalitě (5µ) 
1 8305 Vřeteno HF a zařízení pro vnitřní broušení 6000 - 24000 U/min 0,8 KW s 

měničem kmitočtu, sada kabelů a upínacích pouzder ER11 (3 a 6 mm) 
99999 Orovnávací diamant PKD pro orovnávání korundových brusných kotoučů 
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38. ÚDRŽBA 
Brousící stroj pro nástroje FSM-CNC nepotřebuje žádnou speciální 
údržbu. Pravidelné čištění a dobrá péče zajistí dlouhou životnost 
stroje. 
Pro zajištění přesnosti stroje je nutné dodržovat pokyny pro mazání stroje. 
Používejte výlučně druhy olejů, které jsou uvedeny v pokynech pro mazání 
stroje (str. 43). 

 
Příležitostně zkontrolujte síťový kabel a zástrčku, zda nejsou poškozené, 
zkontrolujte rovněž systém chladících prostředků na těsnost. 

 
Mazivo chladícího prostředku zkontrolujte podle směrnic výrobce chladících 
prostředků. 

Nepoužívejte agresivní maziva chladícího prostředku nebo čistící prostředky! 
 
 

39. ČIŠTĚNÍ STROJE 
Pro zajištění dlouhodobého bezpečného fungování brusky na nástroje FSM-
CNC je nutno stroj pravidelně (v závislosti na rozsahu nasazení) čistit.   

 
Brusný prach ze stroje odstraňte chladícím prostředkem a štětcem, pevně ulpělá 
znečištění očistěte běžným čisticím prostředkem na stroje. 

 
Nepoužívejte žádné agresivní čisticí prostředky !! 

 
Při čištění stroje je zakázáno provádět oplachy vnitřních částí 
ochranných krytů chladicími mazivy nebo čisticími prostředky! 

 
Pro zabránění před korozí je nutno holé a mořené strojní části ošetřit olejovým 
filmem.  
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40. MAZÁNÍ STROJE 
Tyto FSM-CNC jsou vybaveny automatickým centrálním mazáním. 
Přitom je nutno pravidelně kontrolovat stav naplnění a případně 
doplnit olejem pro vodicí plochy CGLP 68 (specifikace podle DIN 51 
502). 

 
Centrální mazací nádrž nesmí být přeplněna (viz označení MAX. ) 

 
Důležitý pokyn: Minimální stav je monitorován řízením !! 

 
Pokud dojde k podkročení minimálního stavu oleje, nelze provést 
přechod z ručního režimu do automatiky nebo do MDI !!! 

Olej pro vodicí plochy CGLP 68 zakoupíte téměř u každého výrobce maziv. 
 
Při déle trvajícím odstavení os lze mazací automatiku manuálně odpojit. Toto 
se provádí přes tlačítko  

 
Dbejte vždy na to, že při provozu je nutno mazací automatiku tímtéž tlačítkem 
opět zapnout. 

Olej pro vodicí plochy 
CGLP68 plňte zde 

Stav oleje se musí vždy nacházet mezi MIN a MAX. 
 

Nádrž se nesmí přeplňovat ! 

Zde stiskněte pro  
ruční mazací 

impulz 
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41. OPRAVA 

Opravy stroje FSM-CNC a jeho konstrukčních skupin smí provádět pouze závod 
Kaindl nebo jím zmocněné osoby. 

Netýká se to výměny opotřebených dílů. 
 
Výměnu elektrických dílů smí provádět pouze odborný elektrikář! 

 

42. OPRAVA / LIKVIDACE STROJE 
V RÁMCI EU 

Při volných dodávkách do našeho závodu přebírá firma Kaindl-Schleiftechnik 
Reiling GmbH odpovědnost za odbornou likvidaci starých strojů v souladu s 
právě platnými směrnicemi Evropského zákona o odpadních elektrických a 
elektronických zařízeních. 
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43. NASTAVENÍ SÍTĚ 
Standardní nastavení je DHCP. 
IP-Adresa se načítá přes server DHCP (většinou přes router), který 
tuto funkci poskytuje. 
Samozřejmě je možné řízení přiřadit i pevnou IP-adresu tak, že ji zadáte 
manuálně. Abyste se dostali do níže zobrazené obrazovky, systémová 
nastavení provozního systému naleznete v Dashboardu > Systémová 
nastavení: 

 
 

 
Přes Systémová nastavení se dostanete k nastavením SÍŤ síťového připojení (Ethernetové 
spojení). 
Zde lze poté provádět nastavení k IP adrese, Gateway (routerové drese) atp. 
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Obr. níže zobrazuje masku k zapsání pevné adresy IP ve vaší síti. 
 

 
Pokud si budete přát pevné přiřazení adresy IP, je nutné si k tomuto osvojit 
dresu MAC.  Tuto adresu MAC získáte přes „Dashboard > Terminal", a to tak, 
že zde zadáte příkaz „ifconfig“ a tento potvrdíte pomocí "Enter". Získáte tak nyní 
všechna síťová nastavení v textu, včetně adresy MAC. 

 

44. VZDÁLENÁ ÚDRŽBA 
Řízení IPC disponuje možností vzdálené údržby přes internet. Provozní systém 
disponuje programem vzdálené údržby "Teamviewer" 

 
POKYN: Vzdálenou údržbu vašeho stroje lze provádět pouze při vaší přítomnosti 
u stroje. Tato údržba je podpořena telefonicky, jelikož je nutno provádět 
manuální potvrzení uživatele na řízení, resp. budeme požadovat ID a heslo 
vedoucího týmu.  
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45. ZÁRUKA 
Záruční lhůta činí 12 měsíců od data dodání a vztahuje se na jednosměnný 
provoz. U vícesměnného provozu činí garanční lhůta 6 měsíců od data dodání, 
při dodržování nasazení stroje v souladu s jeho předmětem určení a povinné 
péče provozovatele. 

 
Záruční plnění zahrnuje náklady výměny defektních dílů a konstrukčních 
skupin (mohou to být i zprovozněné použité díly a konstrukční skupiny), vč. 
potřebné pracovní doby. 

Z jakékoli záruky jsou vyloučeny: 

• provozem podmíněné rychle opotřebitelné součásti 
• poškození při přepravě 
• škody nepřiměřeným používáním stroje 
• poškození programovacími chybami nebo chybami v programových 

parametrech 
• poškození působením hrubé síly 
• škody a následné škody, které vznikly porušením povinné péče 

provozovatele nebo nedodržováním bezpečnostních pokynů 
• škody agresivními, ostrými nebo leptajícími látkami a 

rozpouštědly atp., nebo agresivními chladicími mazivy 
 
V případě záručních požadavků nám prosím sdělte, které látky poškození 
způsobily. Prosím, bezpodmínečně je nutno uvést název typu stroje, sériové číslo 
a rok výroby stroje. 

 
Bez uvedení roku výroby a čísla stroje nebude váš požadavek v 
naší firmou vyřízen! 

 
Zaslání stroje do naší firmy je bez předchozího souhlasu zakázáno. 
Vyhrazujeme si právo naúčtovat si přepravní náklady za neodsouhlasené 
zpětné zásilky. 

 
Díly, které byly vyměněné nebo nahrazené v rámci záruky, se stávají naším 
majetkem. 
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46. VARIANTY STROJE 
V této kapitole se dozvíte vše o dostupných variantách stroje, včetně jejich 
popisu a ovládání. 

46.1 BROUŠENÍ PIL 
Pomocí varianty SSM-CNC je možné na FSM-CNC brousit pilové kotouče, a od Ø cca 100 
mm do max. Ø 450 mm. 
Sada obsahuje horizontální kruhovou osu, magnetické upevnění, dvě příruby pilového 
kotouče a různé redukce pro vrty pilových kotoučů, USB flash disk se speciální strojní 
konfigurací a různými dialogovými brousícími programy pro pilové kotouče. Varianta 
"kovových pilových kotoučů" není zahrnuta, lze ji však kdykoli doobjednat a Vaše sada tak 
bude kompletní. (popis viz str. 59) 

 
Pokyn: 
Ve spojení s variantou vřetene HF lze  na pilových kotoučích rovněž provádět opravná 
broušení nebo broušení dutinkových zubů. 
Jestliže byl objednán stroj s touto variantou, jsou brusné programy a k tomu potřebné strojní 
konfigurace instalovány již v řízení. 

 
Touto variantou lze stroj kdykoli dodatečně dovybavit ! 
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47.1.2 PŘESTAVBA BROUŠENÍ PIL 
Přestavba FSM-CNC na brusku pilových kotoučů je záležitostí několika pohybů. 1.
 Ukončete PPC a nakonec vypněte stroj (hlavním vypínačem). 
2. Odpojte zásuvné spoje (str. 16) od osy A. 
3. Otevřete upnutí úhlového nastavení osy A a sejměte osu A z úhlové desky. 
4. Nyní na úhlovou desku přimontujte horizontální kruhovou osu a nastavte ji na 0° a 

upnutí úhlového nastavení osy A opět uzavřete. 
5. Nyní spojte konektory s horizontální kruhovou osou 

zásuvných spojů pro osu A (str. 16). 
6. Před horizontální kruhovou osu (obr. 2) přimontujte upnutí pilového 

kotouče a uzavřete magnetické upevnění k připravené zásuvce (obr. 3). 
7. Opět stroj zapněte a nechte rozjet PPC. 
8. Do zdířky USB pro PPC vsuňte dodaný USB flash disk a přímo do seznamu 

/home/cnc zkopírujte zde obsažené složky KAINDL-SSM. 
9. Spojení zobrazte na ploše svého stolního počítače tak, že otevřete složku  

KAINDL-SSM/language a příkazové spojení si přetáhnete do stolního počítače. 
10. Kliknutím na spojení v deskovém počítači nyní spustíte novou strojní 

konfiguraci. 
11. Vyrovnejte magnetické upevnění podle příruby pilového kotouče (obr. 1) a pro střed 

brusného kotouče položte NPV pro Z v G54. 
 

Vyrovnání 
magnetického 
upevnění a 
brusného kotouče 

 
 
 

  

Obr. 
 

Zásuvka pro 
magnetické upevnění  

Obr. 2 

Obr. 1 
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47.1.3 BROUŠENÍ PIL 
Nejprve zvolte upínací přírubu pilového kotouče vhodnou k vašemu pilovému kotouči a tuto 
přimontujte do weldonového uchycení (Weldon ø30) vaší horizontální kruhové osy a upevněte 
upínací přírubu pilového kotouče pomocí upínacího šroubu weldonového uchycení. Nyní zvolte 
vhodný redukční kroužek pro váš otvor pilového kotouče ve středu. Nyní vložte svůj pilový 
kotouč a upevněte jej upevněním krycí desky upínací příruby pilového kotouče a ručně 
utáhněte upínací šroub. Zasuňte nyní kameru do horního kamerového upevnění tak, aby byla 
kamera nasměrována přímo na stůl stroje (obr.). Pohybem os X a Y v ručním režimu pomocí 
ručního kolečka nyní kamerou vyhledejte střed upínací příruby pilového kotouče a položte jej 
pomocí "Set_Coordinates" v G58 NPV jako polohu kamery pro pozdější použití. 

 

  
Osou X nyní pohybujte tak dlouho, dokud pod kamerou neuvidíte zub pily. Kamerovým 
softwarem nyní lze stanovit úhel čela zubu. Prosím, dbejte na to, že je horizontální osa 
nastavena na 0°. 
Označte zub pily, který byl změřen, otevřete upevnění úhlového nastavení a nastavte 
horizontální kruhovou osu na změřenou úhlovou hodnotu a opět uzavřete upevnění úhlového 
nastavení. 
Nyní kamerou (pohyby osou X a Y) sledujte zub pily a opět zkontrolujte úhel. 
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Pokud nebude při opakovaném měření úhlová poloha správná, nasměrujte zub 
pily zaměřovacím křížem kamery a čela zubu. 
Hřbet zubu je nyní nutno změřit. Tyto údaje budou totiž potřeba pro dialog 
brusného programu. 
V editoru nyní otevřete brusný program a vyplňte proměnné s příslušnými 
hodnotami, které se nachází v dialogové oblasti. 
V ručním režimu se brusným kotoučem dotkněte pilového kotouče na čele zubu 
označeného zubu pily a položte NPV G54 pro osy Y a A pod "Set_Coordinates“. 
Pohybujte osou X směrem od pilového zubu do takové vzdálenosti, aby bylo 
možné osu Y posunout 0.5 mm ve směru čela zubu. 
Pohybujte nyní osou X ve směru zubu pily dokud se brusným kotoučem 
nedotknete zubu a položte pak NPV G54 pro osu X pod "Set_Coordinates“. 
Osou X pohybujte směrem od zubu pily. Nyní lze brusný program spustit v 
automatickém režimu. 

Úhlová stupnice kruhové osy 
 

 
 

Dotyk čela zubu Dotyk hřbetu zubu 
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47.1.4 ZVLÁŠTNÍ MOŽNOSTI 
S variantou vřetene HF lze realizovat velmi specifické možnosti. Tímto lze provádět 
u nově zapájených zubů pily opravné broušení nebo provádět dobrušování 
speciálních pilových kotoučů s dutinkovým výbrusem nebo vybrušovat kotouč pily. 

 
Opravné broušení na horní straně zubu 
Opravné broušení na dolní straně zubu 

 

  
Broušení dutinkového zubu 

 

 

52  



 

 

47.1.5 BROUŠENÍ KOTOUČOVÝCH NOŽŮ 
Pomocí horizontální kruhové osy a 3 osové konfigurace (FSM kruh) lze 
bezproblémově brousit i kotoučové nože. 
Komfortní je, že kotoučové nože zde lze brousit shora i zespodu v témže upnutí (v 
závislosti na Ø kruhového nože a brusných kotoučů Ø) 

 
 

Kotoučový nůž 1. Prosím 
proveďte broušení. Řezné 
hrany tak získají dutinkový 
výbrus, který je závislý na 
poloměru brusného 
kotouče. 

 
 
 
 
 
 
 
 
 
 
 
 

Kotoučový nůž 2. Prosím 
proveďte broušení. Řezné 
hrany tak získají dutinkový 
výbrus, který je závislý na 
poloměru brusného kotouče. 
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47.2 3D-HRANOVÝ SENZOR KT130 
Jako nejnovější příslušenství stroje FSM-CNC nabízíme 3D hranový senzor KT1 30 s kabelovým 
připojením. 
Pomocí 3D hranového senzoru lze automatizovaně provádět měřící funkce. Je možné 
sestavovat programy, které jsou například schopné měřit obrobky, nebo stanovit směr řezné 
hrany řezných nástrojů, stanovit délku vyložení atp. (bližší pokyny k měřícím funkcím 
naleznete v návodu k programování funkcí G38.x) 
FSM-CNC lze kdykoli dovybavit touto variantou. 

 

 

54  



 

3D hranovým senzorem KT1 30 lze měření provádět i v ručním režimu. 
Hranový senzor se spouští příkazem M1 03 a příkazem M104 se opět vypíná (viz. str. 33) 
Aby bylo  možné používat 3D hranový senzor KT1 30 v ručním režimu, je nutno 
nejprve uzavřít ochranná dvířka a přejít na provozní režim MDI. 
Do příkazového řádku zapište M1 03 [Enter]. 
Nyní je 3D hranový senzor KT1 30 zapnutý a vy můžete přejít do ručního provozního režimu a 
používat hranový senzor. Kliknutím na zobrazení os můžete označit osu, kterou potřebujete 
pohybovat a tlačítkem "+“ nebo "-“ jí pohybovat požadovaným směrem. 
(Náhled směru vždy vychází od brusného kotouče; viz str. 13). Jakmile je proveden 
dotyk hranového senzoru, dojde k automatickému zastavení posunu. 
3D hranový senzor KT1 30 funguje na všech 4 osách a může je při dotyku i 
zastavit (viz rovněž str. 22). 

 
Pokyn: 
K zastavení je vždy nutná změna signálu na hranovém senzoru (dotyk). K 
samostatnému zastavení dochází při prvním dotyku (změna signálu), pokud ještě 
jednou stisknete tlačítko "+" nebo "", ačkoli se hranový snímač zastavil z důvodu 
dotyku, 
dojde ke spuštění posuvu a poškození hranového senzoru !!! 

 
POZOR: 
Pokud budete osami pohybovat ručním kolečkem (Jogwheel), nikdy k zastavení 
posuvu nedojde, bez ohledu na  změnu signálu !!! 

 
 
 

 

Zásuvka pro 3D hranový 
snímač KT1 30  
Zasunování nebo vytahování 
provádějte pouze při vypnutém 
stroji! 
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POZNÁMKY 
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POZNÁMKY 
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POZNÁMKY 
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NÁVOD K OBSLUZE 
Varianty programových balíčků pro broušení kovových 

pilových kotoučů při tvaru zubů podle DIN1838 "B"; "BW" a "C" 
Pro 

FSM-CNC 
 
 
 

 

 
 

Překlad originálního návodu k obsluze 
Uschovejte prosím pro budoucí používání! 

V 1.0 Ultima lima 08. 2016 
Kaindl-Schleiftechnik REILING GmbH, Remchinger Str. 4, D-75203 Königsbach-Stein 

Tel.: +49 7232/4001 -0, Fax.: +49 7232/4001 -30, Internet: www.kaindl.de, E-Mail: info@kaindl.de 
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Softwarová licenční smlouva firmy Kaindl pro brusné programy CNC 
 

Dodáním univerzálního brusky FSM-CNC s instalovanými brusnými programy CNC 
nebo od instalace brusných programů CNC (lze dokoupit) poskytujete souhlas s touto 
smlouvou o uživatelské licenci k softwaru. 

 
Právoplatná smlouva se uzavírá s vaším souhlasem mezi vámi jako koncovým 
uživatelem softwaru (dále jen „uživatelem“) a společností Kaindl-Schleiftechnik 
REILING GMBH. 

 
Souhlasem s touto smlouvou Vám spol. Kaindl-Schleiftechnik REILING GMBH uděluje 
nevýlučnou licenci k užívání instalovaného softwaru (dále jen pro „brusné programy 
CNC“) v řízení FSM-CNC.  

1. Vlastnické právo 
 
U programů CNC se jedná o autorsky chráněný materiál. Touto smlouvou se nestáváte 
vlastníkem brousících programů CNC, jste však oprávněn k jejich používání v souladu s 
podmínkami uvedenými v této smlouvě. Nejsou udělena práva přesahující rámec této 
smlouvy. 

2. Rozsah užívání 
 
Společnost Kaindl-Schleiftechnik REILING GmbH vám touto licencí uděluje právo k 
užívání programů CNC pro řízení, které je součástí univerzálního brousícího stroje FSM-
CNC. Užívání zde znamená trvalé nebo přechodné používání CNC programů uložením, 
stahováním, přehráváním nebo zobrazováním za cílem provádění programu a 
zpracovávání údajů, které tímto programem získáte. Využívání na jiném hardwaru je 
povoleno pouze při uzavření další licenční smlouvy.  

3. Právo na rozmnožování díla  
 
(1) Uživatel smí programy CNC rozmnožovat, pouze pokud je to nutné k používání. 
Sem patří instalace i stahování do paměti. 

 
(2) Uživatel je oprávněn ke zhotovení další náhradní kopie, pokud je to potřebné pro 
zajištění budoucího používání. Tuto kopii je nutné označit jako poskytnutý program. 

 
Pro uživatele, kteří se rozhodnou z důvodu zajištění dat nebo rychlé reaktivace 
počítačového systému po totálním výpadku pro turnusové zabezpečení kompletního 
stavu dat, vč. používaných brousících programů CNC, je povoleno tyto zhotovovat 
pouze v nezbytně nutném počtu. Tyto smí být používány pouze k archivním účelům. 

 
(3) Zhotovování dalších kopií je zakázáno. Je zakázáno zhotovovat kopie 
dokumentace. 

 
(4) Zakázaná je rovněž dekompilace, pokud není výslovně povolena zákonnými předpisy. 

 
Je zakázáno provádět změny názvů obsažených firem, sériových čísel a jiných znaků, 
které slouží k identifikaci programu. Rovněž je zakázáno provádět změny na údajích o 
výhradních právech. 
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4. Předání 
 
(1) Tato smlouva zaniká automaticky s předáním programů, příp. univerzálního brousícího 
stroje FSM-CNC třetím osobám ve vztahu k uživateli.  Tato třetí osoba nastupuje na místo 
uživatele. 

 
(2) Předání brousících programů CNC lze uskutečnit pouze po prohlášení souhlasu třetí osoby 
vůči předávajícímu uživateli o platnosti ustanovení uvedených v této smlouvě.  Uživatel je 
povinen třetí osobu s ustanovením této smlouvy seznámit. Pokud uživatel tento smluvní text 
nemá k dispozici, může je na vlastní náklady získat od firmy Kaindl-Schleiftechnik REILING 
GMBH. 

 
(3) Uživatel je povinen ihned po předání vymazat nebo jakýmkoli způsobem zničit veškeré 
kopie i dílčí kopie i změněná nebo přepracovaná vydání. To platí i pro zálohové kopie. 

 
(4) Uživatel není oprávněn k dělení nebo pronájmu, prodávání nebo jakémukoli jinému 
přenášení nebo dalšímu postupování jemu poskytnutých práv nebo dílčích licencí, pokud to 
není povoleno touto smlouvou. 

5. Záruka 

(1) Společnost Kaindl-Schleiftechnik REILING GMBH ručí pouze za originální programy 
Kaindl. 

 
(2) Výroba Softwaru, který by pracoval za všech uživatelských podmínek, nelze podle stavu 
techniky zaručit. Společnost Kaindl-Schleiftechnik REILING GMBH učinila vše potřebné, aby 
byl software a dokumentace v okamžiku dodávky v bezvadném stavu a měly potřebné 
vlastnosti. Pokud by se i přesto objevily vady, je společnost Kaindl-Schleiftechnik REILING 
GMBH připravena vady během 3 měsíční záruční lhůty odstranit.    Společnost Kaindl- 
Schleiftechnik REILING GMBH zvolí, zda provede bezplatnou opravu nebo náhradní dodávku. 

 
(3) Záruční lhůta začíná vyskladněním programů, příp. univerzálního brousícího stroje FSM-
CNC, na jejímž řízení jsou programy instalovány. 

 
(4) Pokud nebude možné zajistit opravu nebo náhradní dodávku v přiměřené lhůtě, je uživatel 
oprávněn požadovat snížení ceny nebo odstoupení od smlouvy (změnu).   Za selhání lze 
považovat pouze, pokud byly společnosti Kaindl-Schleiftechnik REILING GMBH poskytnuty 
dostatečné podmínky, avšak i přes tyto podmínky by z určitých důvodů nezvládla chyby 
odstranit. 

 
(5) Záruční plnění je vyloučené, pokud došlo k zneužití, chybnému použití nebo použití ve 
vadných zařízeních nebo při chybných parametrech. 

 
(6) Třetí osoby nesmí odstraňovat chyby. V tomto případě je společnost Kaindl-Schleiftechnik 
REILING GMBH podle svého uvážení oprávněna odstoupit od smlouvy nebo poskytnout 
nejnovější programovou verzi. Prodloužení záruční lhůty bude tímto vyloučeno. 

 
(7) Společnost Kaindl-Schleiftechnik REILING GMBH neručí za chyby 
způsobené při stahování nebo jiný druh přenosu. 
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6. Omezení odpovědnosti 
 
(1) Společnost Kaindl-Schleiftechnik REILING GMBH ručí pouze za schválnost nebo 
nedbalost a za chybějící přislíbené vlastnosti. Dále je používání softwaru rizikem 
uživatele.  

 
(2) Společnost Kaindl-Schleiftechnik REILING GMBH ručí pouze do výše která je 
maximálně ve výši předávací ceny. 

 
(3) Ručení za ztrátu dat se navíc omezuje na typické náklady spojené s obnovením, 
které nastanou při pravidelném a rutinním zhotovováním náhradních kopií, avšak do 
míry, která je uvedena pod  6 (2). 

(4) Ručení v souladu se zákonem o odpovědnosti za škodu způsobenou vadou 
výrobku zůstává nedotčeno. 

 

7. Vyloučení záruky 
 
Společnost Kaindl-Schleiftechnik REILING GMBH neručí za bezprostřední či nepřímé 
následné škody, za ušlý zisk, který by byl způsoben nepoužitelností softwaru, i když 
byla společnost Kaindl-Schleiftechnik REILING GMBH o takovéto škodě informována. 
Toto vyloučení se vztahuje ke škodám právního jmění jakéhokoli druhu. 

8. Povinnost prohlídky a reklamační povinnost 
 
(1) Uživatel je povinen prověřit brousící programy CNC na rozlišitelné chyby. Jedná se o 
zjevné chyby, kterých si je schopen všimnout běžný zákazník. Tyto vady musí být 
během 14 dnů po převzetí dodávky softwaru nebo univerzálního brousícího stroje FSM-
CNC reklamovány, jinak odpadá záruční povinnost společnosti Kaindl-Schleiftechnik 
REILING GMBH. 

(2) Skryté chyby je nutno reklamovat během po jejich zjištění.  
 
(3) Další povinnosti uživatele v obchodním styku zůstávají nedotčeny. 

(4) Při porušení této povinnosti se software považuje za schválené. 
 

9. Výlučnost, písemná forma 
 
(1) V této smlouvě je právní poměr mezi uživatelem a společností Kaindl- 
Schleiftechnik REILING GMBH ve vztahu k neposkytnutým smluvním povinnostem 
rozsáhle ošetřen. Další vedlejší dohody nebyly sjednány. Případné dohody nebo 
ujednání, které byly sjednány do okamžiku platnosti této smlouvy jsou tímto 
zrušeny. 

 
(2) Jakákoli změna této licence je možná pouze písemně. Samotnou změnu 
požadavku písemné formy je rovněž nutno provádět písemnou formou. 
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10. Zachování tajemství. 
 
(1) Uživatel se zavazuje, že ze všech svých možností zajistí veškerá možná opatření pro 
zabránění přístupu nepovolaným osobám k brousícím programům CNC nebo k 
dokumentaci, zabrání neoprávněným tvorbám kopií a jiných, ani dílčích reprodukcí ! 
Zveřejnění předmětu smlouvy. 

 
(2) Tímto se sjednává uchovávání těch informací v tajnosti, které souvisí s realizací této 
smlouvy, které mohou být využívány k vývoji, výrobě nebo prodeji programu nebo k 
jinému používání, a které by mohlo být označováno jako jednání porušující autorská 
práva.  

11. Obecné informace 
 
(1) (Salvátorská klauzule) Pokud by bylo jedno nebo více ustanovení této smlouvy z 
jakéhokoli důvodu zcela nebo částečně neplatné, nemá to vliv na platnost zbývajících 
ustanovení této smlouvy. 

 
(2) Veškerá sdělení adresovaná společnosti Kaindl-Schleiftechnik REILING GMBH je 
nutno zasílat na následující adresu: 

 
Kaindl-Schleiftechnik 
REILING GMBH 
Remchinger Strasse 4 
75203 Königsbach-Stein 

 

(3) Na tuto smlouvu se vztahuje právo SRN. 
 
(4) Jestliže je uživatel podnikatelský subjekt zapsaný v OR, ve smyslu 
obchodního zákoníku právní osoba veřejného práva nebo veřejně právní fond, 
příslušným soudem pro řešení všech sporů, které nastanou přímo nebo nepřímo 
v souvislosti s touto smlouvou.   
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POPIS VÝROBKU 
 

Programy CNC "Broušení kovových pilových kotoučů" slouží výlučně k 
broušení s univerzální bruskou FSM-CNC ve spojení s variantou "Broušení 
pilových kotoučů", kovových pilových kotoučů s členěním T5 až T18, s tvarem 
zubů podle DIN 1838 "B", "BW" a "C". 
Oblast průměru začíná na Ø 125 až Ø 315 mm. Pro broušení tvarů zubů budete 
potřebovat ještě brusný kotouč výr. č. 18784 pro průměry větší než Ø1 50 a 
brusný kotouč výr. č.1 8783 pro průměry menší než Ø150 mm. 
Brousící programy je nutno chápat jako univerzální programy, které brousí 
kovové pilové kotouče s univerzálně použitelnou geometrií zubů (úhel čela cca 
12° a úhel hřbetu cca 10°).  
Geometrie zubů je vhodná k řezání většiny ocelí (do 1200N/mm²), šedé litiny, 
hliníku, mosazi a mědí. 

Členění plyne z průměru a počtu zubů. 
 
Příklad: 
Pilový kotouč Ø 315 Z54 

315 x Π = 989.60 mm 
989.60/Z54 = 18,325 mm 

V souladu s tímto plyne i dělení T18 (toleranční rozsah 17,7 do 18,35) 
 
Prosím, pozor! 
Brousící programy CNC nekontrolují logiku vašich zadání v dialogové 
oblasti. 
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TVARY ZUBŮ 
 
Tvary zubů podle DIN 1838 rozlišují 3 různé tvary šroubového zubu: 

Tvar zubu "B" je základním tvarem šroubového zubu. 
Všechny zuby jsou stejně vysoké a bez fází na hřbetu zubu. 

 
Tvar zubu "BW" je pouze rozšířením tvaru zubu "B“ při střídavém fázování 
každého hřbetu zubu jednou doprava a jednou doleva při 45° na 1/3 šířky 
pilového kotouče. (Viz obr. tvar zubu BW) 

 
Tvar zubu "C" zahrnuje základní tvar zubu "B", rozdíl je však ve dvou věcech: 
1. Každý 2. zub je trapézový (vlevo a vpravo při 45°, fázováno vždy 

na 1/3 šířky pilového kotouče) 
2. Každý trapézový zub má jeden výškový rozdíl, který se vždy liší podle členění 
"T". Členění T5 do T10 se výškový rozdíl nachází mezi 0.15 a 0.20 mm, 
u členění T12 do T18 se výškový rozdíl nachází mezi 0.20 a 0.30 mm. 
U brousících programů můžete volně volit a přizpůsobovat daným 
potřebám. 
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PŘESTAVBA BROUŠENÍ KOVOVÝCH PIL 
Přestavba FSM-CNC na brusku pilových kotoučů je záležitostí několika pohybů. 1.
 Ukončete PPC a nakonec vypněte stroj (hlavním vypínačem). 
2. Odpojte zásuvné spoje (str. 16) od osy A. 
3. Otevřete upnutí úhlového nastavení osy A a sejměte osu A z úhlové desky. 
4. Nyní na úhlovou desku přimontujte horizontální kruhovou osu a nastavte ji na 0° a upnutí 

úhlového nastavení osy A opět uzavřete. 
5. Nyní spojte konektor horizontální kruhové osy se 

zásuvným spojem osy A (návod k použití na str. 16) 
6. Otevřete upevňovací šrouby úhlové desky a úhlovou desku posuňte s horizontální 

osou dopředu. Prosím dbejte na rozměr 120 mm (str. 10, obr. 1) 
7. Před horizontální kruhovou osu (obr. 2) přimontujte upnutí pilového kotouče a 

uzavřete magnetické upevnění k připravené zásuvce (obr. 3). 
8. Opět stroj zapněte a nechte rozjet PPC. 
9. Do zdířky USB pro PPC vsuňte dodaný USB flash disk a přímo do seznamu zkopírujte 

zde obsažené složky HSS-Saege (Pila-HSS). 
/home/cnc/KAINDL-SSM/nc-files/ 

10. Vyrovnejte magnetické upevnění podle příruby pilového kotouče (obr. 1) a pro střed 
brusného kotouče položte NPV pro Z v G54. 

Vyrovnání 
magnetického 
upevnění a brusného 
kotouče 

 
 
 

  

Zásuvka pro 
magnetické upevnění 

Obr. 
 

Obr. 2 

Obr. 1 
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Aby bylo nyní možné správně brousit šroubový zub, je nutno ještě 
provést několik malých nastavení. 
Velkou pozornost je nutno klást na polohu horizontální osy 
(viz obr. 1 a str. 9 bod 6.) 

 
Nyní proveďte montáž brusného kotouče výr. č. 18784 na brusné vřeteno pro 
pily při Ø menším než 150 mm nebo brusný kotouč výr. č. 18783 pro pily o Ø 
větším než 150 mm. 

 
Otočte nyní věží osy Z o 11° ve směru hodinových ručiček 
(viz obr. 2 a také návod k obsluze na str. 17, kap. 16.1 ) 

 
 
 
 

 
 
 

11° pro T5 až T18 
 

 

Obr. 2 

Obr. 1 
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SEŘÍZENÍ KAMERY 
 

Nyní je nutno kameru nově vyrovnat, jelikož rysky zaměřovacího kříže jsou nyní posunuty o 
11°. Postupujte nyní následujícím způsobem: 

 
1. Posunujte nyní osou X v ručním režimu pomocí jogwheelu ve směru k některému 

volnému místu na stolu stroje. 
 
2. Na stůl stroje položte list papíru a na tento papír položte příložný úhelník. Tento 

příložný úhelník přiložte na stůl stroje podle obr. 1. 
 
3. Osami X a Y nyní pohybujte takovým způsobem, aby kamera zachytila hranu 

příložného úhelníku, nastavte na „Ostré“ a pohybujte osou Z. 
 
4. Trošku otevřete upnutí kamery (kruhové upnutí) a nastavte zaměřovací kříž na 

hraně příložného úhelníku (obr. na str. 12). 
 
5. Uzavřete upnutí kamery a zkontrolujte správnost vašeho nastavení. 

 
Kamera je nyní připravena k vyrovnání kovových pilových kotoučů! 

 
Více informací naleznete rovněž v Návodu k obsluze na str. 28 kap. 25.1 stroje FSMCNC. 

 
 
 

 

Obr. 1 
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Tak, jako na obrázku níže, vypadá správně seřízená kamera. 
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BROUŠENÍ KOVOVÝCH PIL 
Nejprve zvolte upínací přírubu pilového kotouče vhodnou k vašemu pilovému kotouči a tuto 
přimontujte do weldonového uchycení (Weldon ø30) vaší horizontální kruhové osy a upevněte 
upínací přírubu pilového kotouče pomocí upínacího šroubu weldonového uchycení. Nyní zvolte 
vhodný redukční kroužek pro váš otvor pilového kotouče ve středu. Nyní vložte svůj pilový 
kotouč a upevněte jej upevněním krycí desky upínací příruby pilového kotouče a ručně 
utáhněte upínací šroub. Zasuňte nyní kameru do horního kamerového upevnění tak, aby byla 
kamera nasměrována přímo na stůl stroje (obr.). Pohybem os X a Y v ručním režimu pomocí 
ručního kolečka nyní kamerou vyhledejte střed upínací příruby pilového kotouče a položte jej 
pomocí "Set_Coordinates" v G56 NPV jako polohu kamery pro pozdější použití. 

 

 
Osou X nyní pohybujte tak dlouho, dokud pod kamerou neuvidíte zub pily. 
Pomocí jogwheelu nyní otáčejte osou A dokud neuvidíte zub pily, jak je znázorněn na obrázku 
dole vlevo. U tvarů zubů "BW" a "C" je v kameře vidět fáze zubu 45°.  Prosím, dbejte na to, že 
je horizontální osa nastavena na 0°. Označte tento zub pily a položte ho o půlku členění ve 
směru A 
(viz obr. dole vpravo). Půlka členění (T/2) je nutná, aby bylo možné zub pily zbrousit v 
průměrové neutrální poloze. 
Pomocí "Set_Coordinates" v G54 ose A položte nulový bod. 
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Polovina členění se vypočítá pomocí násl. rovnice: T/2 
= 360°/(počet zubů x 2) 
Příklad: 

Pilový kotouč Ø31 5 Z54 
T/2 = 360°/(Z54 x 2) = 360°/1 08 =3,333333° T/2 = 
3.333333° 

 
 
V editoru nyní otevřete brusný program CNC (volba podle tvaru zubu "B" ; "BW" 
; "C" a dělení "T") a vyplňte proměnné s příslušnými hodnotami, které se 
nachází v dialogové oblasti. 
V ručním režimu se brusným kotoučem dotkněte pilového kotouče na čele zubu 
označeného zubu pily a položte NPV G54 pro osu Y pod "Set_Coordinates“. 
Poté se v ručním režimu brusným kotoučem dotkněte pilového kotouče na 
hřbetu zubu označeného zubu pily a položte NPV G54 pro osu X pod 
"Set_Coordinates“. 
Osou X pohybujte cca 10 mm směrem od zubu pily (v mínusovém směru). 
Nyní lze brusný program spustit v automatickém režimu. 

 
 
 
 
 
 
 

Poloha dotyku s 
brusným 
kotoučem na 
hřbetu zubu. 

Poloha dotyku s 
brusným 
kotoučem na 
čele zubu. 
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NOVÉ OZUBENÍ KOVOVÉ PILY 
Pokud zhotovujeme nové ozubení, je nutno nejprve „staré“ zuby pily odbrousit. 

 
To provedeme nejlépe pomocí strojní konfigurace Kaindl-FSM-RMS. Tato 
strojní konfigurace je částí varianty "Broušení pilových kotoučů" V podstatě 
odbrousíme staré ozubení, jako bychom zbrušovali "kotoučový nůž“ s jediným 
rozdílem, že „tupé“ ozubení odbrousíme. 

 
Při zhotovování nového ozubení postupujte, viz výše popsané „Broušení 
kovových pil“. Jediným rozdílem je, že vám bude pro orientaci chybět zub. 

 
* Tenkou barevnou tužkou proto proveďte na neobrobeném kusu 
pilového kotouče drobné označení. 

* Nyní toto označení nasměrujte jako zub pily (str. 13). 
 
* Vaše poloha dotyku pomocí brusného kotouče se nachází u značení 
na Ø pro hřbet zubu,  
a kousek před značením čela zubu. 

 
* Podle této polohy položte nulový bod v G54 přesně jak je popsáno na straně 
13 a 14. 

* Za tímto účelem otevřete program vždy podle členění, které budete požadovat 
T...-Neu.ngc. 

* Do dialogového pole zadávejte hodnoty podle svých požadavků. 
 

Prosím, pozor ! 
Programy kontrolují Vaše zadání, nikoli logickou správnost!!! 

 
Nyní můžete vámi zvolený program CNC spustit. 

 
Prosím, pozor ! 

Vybrušuje se pouze základní ozubení. 
Konečné broušení se provádí přes dobrušovací programy pro odpovídající tvary 

zubů "B" ; "BW" a "C". 
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DŮLEŽITÉ POKYNY 
 
* Technické změny za cílem rozvoje jsou výslovně vyhrazeny !  

 
* Použití CNC programů podléhá výluční odpovědnosti provozovatele 

stroje ! 
 
* Programy CNC neprovádí kontrolu údajů na jejich logičnost, tato 

kontrola je odpovědností uživatele ! 
 
* Bezpodmínečně dodržujte návod k obsluze stroje FSMCNC, všechny zde 

uvedené instrukce a bezpečnostní pokyny, mimo jiné rovněž 
„Požadavky na pracovníky obsluhy“ !! 

 
* Příliš vysoké rychlosti posunu a (nebo) příliš hluboký přísun mohou způsobit 

poškození brusného kotouče, obrobku nebo dokonce celého stroje !! 
 
* Chybná anebo nesladěná zadání parametrů v dialogových polích mohou 

způsobit „havárii“. Prosím, zkontrolujte zadání, 
ještě než spustíte program!! 

 
* U kovových pilových kotoučů, se kterými nemáte zkušenosti, je nutno dbát 

zvýšené opatrnosti !! 
Tvarování šroubových zubů může být s vysokou pravděpodobností rozdílné. 
První broušení, prosím, provádějte s malými hodnotami posunu !!! 
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POZNÁMKY 
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POZNÁMKY 
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POZNÁMKY 
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POZNÁMKY 
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